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PREFACE
Every effort has been made to ensure that the information in this document is complete, 
accurate, and up-to-date. The manufacturer assumes no responsibility for the results of 
errors beyond its control. The manufacturer also cannot guarantee that changes in software 
and equipment made by other manufacturers and referred to in this guide will not affect 
the applicability of the information in it. Mention of software products manufactured by 
other companies does not necessarily constitute endorsement by the manufacturer.

While all reasonable efforts have been made to make this document as accurate and helpful 
as possible, we make no warranty of any kind, expressed or implied, as to the accuracy or 
completeness of the information contained herein.

The most up-to-date drivers and manuals are available from the Oki web site:
http://www.okiprintingsolutions.com

07116601 iss. 1; Copyright © 2010 Oki Europe Ltd. All rights reserved.

Oki is a registered trademark of Oki Electric Industry Company, Ltd.

Oki Printing Solutions is a trademark of Oki Data Corporation.

Microsoft, MS-DOS and Windows are registered trademarks of Microsoft Corporation.

Apple, Macintosh, Mac and Mac OS are registered trademarks of Apple Inc.

Other product names and brand names are registered trademarks or trademarks of their 
proprietors.
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NOTES, CAUTIONS AND WARNINGS

Specifications subject to change without notice. All trademarks acknowledged.

NOTE
A note provides additional information to supplement the main text.

CAUTION!

A caution provides additional information which, if ignored, may 
result in equipment malfunction or damage.

WARNING!

A warning provides additional information which, if ignored, may 
result in a risk of personal injury.
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INTRODUCTION

The OkiLAN Internal Print Server is a fast 10BASE-T/100BASE-TX/1000Base-T network 
interface.

This network print server supports IEEE 802.2, IEEE 802.3, Ethernet-II and SNAP, and can 
detect those frame types automatically.

It supports major protocols such as TCP/IP, EtherTalk (Mac) and NetBEUI (Windows).

The print server has a number of security features, including SSL/TLS, IP Filtering, 
disabling unused protocols, etc.

Password protection ensures that the print server is safe from unauthorised changes in 
settings. You can also restrict access by disabling network services, protocols, and ports 
you are not using. You can limit access to specific authorised IP addresses as well.

The SMTP feature allows you to have an E-mail sent to designated addresses when certain 
errors occur.

SECTIONS

This book is divided into the following sections:

> “Section 1: configuring the print server” on page 11

> “Section 2: utilities” on page 35

> “Section 3: printing from Windows” on page 39

> “Section 4: printing using MacOS” on page 42

> “Section 5: troubleshooting” on page 58

NOTE
The network addresses used in this manual are shown for example only. 
Network addresses used in your installation should be within in the 
appropriate address range and have the correct subnet mask for your network 
segment.

NOTE
Change the emulation in the Printer Menu settings to Auto or PS before 
printing the network summary.
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SPECIFICATIONS 

Frame types IEEE 802.2

IEEE 802.3

Ethernet-II, SNAP, AUTO

Network 
interface

1000BASE-T

100BASE-TX

10BASE-T

Network 
protocols

TCP/IP
> Network layer: ARP, RARP, IP, ICMP, PnP
> Session layer: TCP, UDP
> Application layer: PR, FTP, TELNET, HTTP, IPP, BOOTP, DHCP, 

SNMP, DNS, SMTP, POP3

IPX/SPX (NetWare)
> Remote printer mode (up to eight file servers and 32 queues)
> Print server mode (up to eight print servers)
> Encrypted password supported in print server mode
> SNMP

EtherTalk: ELAP, AARP, DDP, AEP, NBP, ZIP, RTMP, ATP, PAP

AppleTalk

Bonjour

NetBEUI: SMB, NetBIOS

Supported 
Operating 
Systems

Windows
> 7
> Server 2008
> Vista
> XP
> 2000

Mac OS X 10.3.9 or later

Print Service LPR

FTP

Port 9100

Web Direct Printing

QSERVER Binder

QSERVER NDS

Functions Self-diagnostic test printing

Banner supported

Monitoring/configure by Web browser

Printer status notification by E-Mail
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NETWORK SUMMARY PRINTOUT

The printer server’s network summary reports the printer’s MAC Address (Ethernet 
address).

1. Turn the printer on.

2. Press the print server Test button for more than three seconds and release.

The printer’s MAC Address (Ethernet address) appears on the first page under General 
Information.

The first six digits of the MAC Address are the same for all OkiLAN print servers.

The last six digits of the MAC Address are unique to each OkiLAN and are required to set 
up the print server.

The hub link status results are also printed (normally “OK”).

NOTE
If anything other than “OK” is displayed see page 59.
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CONFIGURATION METHODS

You can configure the print server by using one of the following methods:

UTILITY FEATURES SYSTEM REQUIREMENTS

Quick Setup

(see page 12)

Configure the print server easily and 
simply without installing any 
software packages into your system.

You can set the following:
> Enable/disable TCP/IP, EtherTalk, 

NetBEUI protocols.
> Set IP address, Subnet Mask and 

Gateway for TCP/IP manually or by 
using DHCP.

> Zone name and Port name for 
EtherTalk.

Windows*
> 7
> Server 2008
> Vista
> XP
> 2000

* with TCP/IP protocol or IPX/
SPX protocol installed.

AdminManager Configure the print server in detail.

Web Browser Configure the print server and 
printer by using a Web browser.

Microsoft Internet Explorer or 
similar.
Operating system that supports 
the Web browser.

TELNET Configure the print server using 
TELNET.

Third-party vendor developed 
TELNET client package.

A TELNET Application is 
standard in Windows.

SNMP The printer and network card can be 
controlled using a third-party vendor 
developed SNMP application.

Third-party vendor developed 
SNMP application.
Introduction > 10
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SECTION 1: CONFIGURING THE PRINT SERVER
This section explains the various ways you can configure your print server.

It consists of the following:

> “Using the adminmanager quick setup” on page 12

> “Using a web browser” on page 30

> “Using adminmanager standard setup” on page 14

> “Using TELNET” on page 33



USING THE ADMINMANAGER QUICK SETUP

INTRODUCTION

The AdminManager Quick Setup utility allows you to configure the print server easily and 
simply without installing any software packages.

You can configure the following:

> Enable/disable TCP/IP, EtherTalk, NetBEUI protocols.

> Set IP address, Subnet Mask and Gateway for TCP/IP manually or by using DHCP.

> Set NetWare mode and create Queue/Print Server/Printer objects.

> Zone name and Port name for EtherTalk.

USING QUICK SETUP

1. Insert the Network & Utilities CD/DVD into the CD/DVD-ROM drive and wait for it to 
autorun.

If the installer does not start automatically, click Start > Run and enter E:\Setup 
(where E is your CD/DVD-ROM drive) in the Open field, then click OK.

2. Select the appropriate language.

3. Accept the Software License Agreement if you have not previously accepted it.

4. Select Device Configuration (a).

5. Then select Install Network card setup (b).

6. If required, select the appropriate language.

NOTE
> This utility can only be used on a PC that can be connected to the network 

with TCP/IP or IPX/SPX.

> This utility must be used on a PC that is located in the same segment as 
the printer.

NOTE
Installation enables the user to create network queues and perform other 
functions.

a

b
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7. Select Oki Device Quick Setup and follow the on-screen instructions.

8. When you are done making your selections, review them and if they are correct, 
click Execute.

The new settings are transmitted to the network card, but the network card is still 
operating with pre-transmission settings.

9. Click Finish to validate the new settings.

The print server re-initialises.
Using the adminmanager quick setup > 13



USING ADMINMANAGER STANDARD SETUP
AdminManager Standard Setup is a powerful Microsoft Windows-based utility for 
configuring all print server functions using a graphical user interface.

INSTALLING ADMINMANAGER

1. Insert the Network & Utilities CD/DVD into the CD/DVD-ROM drive and wait for it to 
autorun.

If the installer does not start automatically, click Start > Run and enter E:\Setup 
(where E is your CD/DVD-ROM drive) in the Open field, then click OK.

2. Select the appropriate language.

3. Accept the Software License Agreement if you have not previously accepted it, then 
select Network Card Standard Setup.

4. Select the Network Card Setup tab (a).

5. Then select Install Network card setup (b).

6. If required, select the appropriate language.

NOTE
> This utility can only be used on a PC that can be connected to the network 

with TCP/IP or IPX/SPX.

> This utility must be used on a PC that is located in the same segment as 
the printer.

a

b
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7. Click Oki Device Standard Setup.

The Welcome window displays. 

Here you can choose:

> run the utility from the CD/DVD Execute from CD-ROM

> load the utility onto your hard drive and run it from there Install and Execute

8. Click Next.

(a) If you selected Install and Execute, follow the on-screen instructions to install 
AdminManager, then see the “The AdminManager interface” on page 16.

(b) If you selected Execute from CD-ROM, see the “The AdminManager interface” 
on page 16.
Using adminmanager standard setup > 15



THE ADMINMANAGER INTERFACE

PULL-DOWN MENUS

FILE MENU

> Search
Locates and lists all printers in your network which have an Oki compatible network 
card installed.

> Exit
Exit the program.

STATUS MENU

> Printer Status
Displays the current status of the printer.

> System Status
Displays the current network card configuration. The configuration data can be 
saved as a log file.

> List of Configuration Items
Displays current configuration. Configuration data can be saved as a log file.

SETUP MENU

> Oki Device Setup
Use this to configure the print server card.

General Tab (Oki Device Setup)

The General tab allows you to change the admin password.

1. Click Change.

2. Enter the current value, then enter the new value and re-enter it under Confirm ….

3. Click OK.

NOTE
To open the standard version of AdminManager from your desktop, click 
Start > Programs > OKI Setup Utility > Admin Manager.

NOTE
The default admin password is the last six digits of the MAC Address, minus 
any punctuation marks. e.g., for a MAC (Ethernet) Address of 
00:80:87:A4:55:79, the password would be A45579.
Using adminmanager standard setup > 16



TCP/IP Tab (Oki Device Setup) 

ITEM COMMENTS 

Use TCP/IP Protocol Enable/disable TCP/IP protocol.

Use DHCP/BOOTP Click to select this item if the IP address, subnet mask, default 
gateway and IP addresses for DNS primary server and 
secondary servers are retrieved from the DHCP or BOOTP 
server.

Use IPv6 Use to enable/disable IPv6.

Use Windows Rally Windows Vista and above only: Use to discover and 
configure devices over a network.

IP Address Set the IP address of the selected network interface card.

Subnet Mask Set the subnet mask of the selected network interface card.

Default Gateway Set the default gateway of the selected network interface card.

Auto Discovery… Use to enable/disable Network PnP and Bonjour, and to set the 
Device Name.

DNS Server… Set IP addresses for DNS primary and secondary servers.

WINS Server… Use to set IP addresses for primary and secondary servers, 
and to enter a Scope ID.
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Netware Tab (Oki Device Setup) 

ITEM COMMENTS

Use NetWare Protocol Enable/disable NetWare protocol.

Use IPX Protocol Click to deselect if you do not wish to use IPX.

Use TCP/IP Protocol Click this to select TCP/IP protocol.

Print Server Name Set a Print Server name.

Frame Type Set the primary NetWare frame type.

Operation Mode Select the NetWare mode:

PSERVER Mode (the default)

RPRINTER Mode

Bindery Setup check 
box.

Click to deselect Bindery. When Bindery Setup is deselected, 
the Bindery Setup… button is greyed out.

Bindery Setup Configure Bindery mode items, including:

File Server to be connected. Specify up to 8 file servers to 
connect.

Password. Set a password for the Print 
Server.

Job Polling Time Set the print job polling 
interval in seconds.

NDS Setup Set the NDS Tree and Context where the Print Server was 
created.

RPRINTER Setup Appears if you select RPRINTER mode under Operation Mode.

The following can be configured:

Print server to be connected. Specify up to 8 file servers to 
connect.

Time Out Set the duration from the 
last data’s arrival to freeing 
of the port, in seconds.

Printer Name Set the NetWare printer object name.
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EtherTalk Tab (Oki Device Setup)

NetBEUI Tab (Oki Device Setup) 

ITEM COMMENTS

Use EtherTalk Protocol Enable/disable EtherTalk protocol.

Printer Name Set the EtherTalk Printer object name.

Zone Name Set the name of the zone to which the print server belongs.

ITEM COMMENTS

Use NetBEUI Protocol Enable/disable NetBEUI protocol.

Short Printer Name Set a name for the print server.

Workgroup Set a name for the work group to which the print server  
belongs.

Comment Set the comments for the print server.
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SNMP Tab (Oki Device Setup) 

ITEM COMMENTS

Use SNMP Service Enable/disable

SNMPv1 settings SNMP Write community Change

SNMP Read community Change

SNMPv3 settings User name Set a user name.

Authorization settings Options to Setup and Delete.

Privacy (encryption) settings Options to Setup and Delete.

SysContact Set the printer manager name.

SysName Set the printer model name.

SysLocation Set the location where the printer is installed.

Printer Trap Setup… The following items can be configured:

Printer Trap Community Name This community name is assigned to 
outgoing printer status traps such as 
off-line, paper out, etc.

TCP #1 through TCP #5 Set up to five IP addresses to which a 
Trap packet will be sent.

Detail… 
[for TCP #1 through TCP #5]

Click to enable sending a Trap packet 
for any or all of the following selectable 
conditions:

Printer Reboot

Receive Illegal

Online

Offline

Paper Out

Paper Jam

Cover Open

Printer Error

IPX Set node address and network address 
to which a Trap packet will be sent.

Detail… [for IPX] Click to enable sending a Trap packet 
for any or all of the following selectable 
conditions:

Online

Offline

Paper Out

Paper Jam

Cover Open

Printer Error
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E-mail(Send) Tab

ITEM COMMENTS

Use SMTP Transmit Enable/disable sending E-mail using SMTP. 

SMTP Server Name Set the host name of the SMTP server. 

Printer E-mail Address Set the E-mail address that is used in the From field in the mail 
header.

Destination Address 1… 
through 5…

Set the following parameters:

Destination 
Address

Set E-mail address to which E-mail should be 
sent.

Notify Mode Select PERIOD or EVENT.

When PERIOD is selected:

Check Time Used to set the interval at which the selected 
events are checked. E-mail will be sent at that 
interval for each selected event which has 
occurred.

Period Mode Set ON/OFF for the events listed.

When EVENT is selected

Event Mode Select Enable (ON), Disable (OFF) or Immediate 
(NoWait, e-mail is sent as soon as the event 
occurs) for the listed events. If Enable is 
selected, the check interval is settable in hours 
and/or minutes (0, 15, 30, or 45).

Attach Info… Select whichever information is to be included in the E-mail.

Comment… Set up to four lines of text to be included with the E-mail as 
comments.

Authentication… Used to set the following security information:

Use SMTP 
Authentication

Enable/disable SMTP authentication.

User ID Set the user ID for authentication.

User Password Set a password for authentication.

Others… Set the following items:

SMTP Port 
Number

Set the port number of SMTP (default is 25).

Reply-To Address Set the E-mail address used for the Reply-To 
field in the mail header
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E-mail(Receive) Tab (Oki Device Setup)

The print server supports an e-mail reception function (POP3) allowing the printer to print 
PDF and text files attached to e-mails. 

Not all printers support this function. If the email receive tab is not displayed, your printer 
does not support this function.

ITEM COMMENTS

Use POP Receive Enable/disable receiving E-Mail via POP3.

POP3 Server Set the IP address or host name of the POP3 server.

POP3 Server UserID Set User ID for POP3 server.

POP3 Server Password Set a password for the POP3 server.

POP Detail… Set the following:

Use APOP Select if you want to use APOP.

POP3 Port Number Set the port number for APOP  (default is 
110).

Mail Polling Time Set interval to retrieve E-Mail(s) from the 
POP3 server. Selectable values,  OFF, 1min, 
5min (default), 10min, 30 min, 60 min.

Use SMTP Receive  Enable/disable SMTP receive.

Domain Filter… Set the following:

Use Domain Filter Enable/disable domain filtering.

Filter Policy Select ACCEPT (the default) or DENY.

Domain Filter Define up to five domain filters.
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SNTP Tab (Oki Device Setup)

ITEM COMMENTS

Use SNTP Enable/disable SNTP (Simple Network Time Protocol).

NTP Server 1 Address Set the IP address or host name for NTP Server 1.

NTP Server 2 Address Set the IP address or host name for NTP Server 2.

Adjust Interval  Set the interval for sending time update requests to the server. 
Select 1 hour (the default), 12 hours or 24 hours.

Local Time Zone Set the local time zone from -12:00 to +13:00. Minute interval 
is selectable from 00 (the default), 15, 30 or 45.

Daylight Saving When this is selected, one hour is added to the local time.
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Maintenance Tab (Oki Device Setup)

ITEM COMMENTS

LAN Scale Select NORMAL (the default) or SMALL.

IP Filter Setup… The following items can be configured:

Use IP FIlter Enable/disable IP Filtering. Default is disabled.

Admin IP Address Enter the printer’s IP Address.

IP Address Range Set up to 10 IP Filter address ranges: IP 
FIlter Range 1 through IIP Filter Range 
10.

Printing Enable/disable printing of the specified IP 
address range. Default is disabled.

Configuration Enable/disable changing IP address ranges. 
Default is disabled.

Service… The following features can be selected by clicking their check box.

TCP/IP Protocol

NetBEUI Protocol 

NetWare Protocol

EtherTalk Protocol

FTP Service

Use Telnet Service

Use Web Service

Use SNMP Service

Use POP3 Protocol

Use SNTP

Use encrypted communication for configuration data
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SSL/TLS Tab (Oki Device Setup)

ITEM COMMENTS

Encryption 
Strength

Set the strength of encryption:

Strong = highest security, slowest speed

Standard = medium security, medium speed

Weak = least security, fastest speed

Self-signed 
Certificate

For IPP encryption within an organisation’s internal network (intranet).

Create 
Certificate…

When Self-signed Certificate is selected, the following items are configured:

Common Name The printer’s IP Address appears here.

Organisation Enter the name of your organization.

Organisation Unit Optional. Allows you to enter a subdivision or department 
name.

Locality Enter the name of the city where the organization is located.

State/Province Enter the state or province where the organisation is located.

Country/Region Enter the country or region where the organisation is 
located.

Key Exchange Method Select RSA (the default) or Diffie-Hellman(DSS).

Key size Select 512, 1024 (the default), or 2048 bits.

Term of Validity Enter a starting and ending date (month/date/year) for 
which the certificate is valid.

CA-signed 
Certificate…

Used for web encryption to provide security when printing over the internet. Requires 
an outside certification service which must be purchased separately.

Create 
Certificate…

When CA-signed Certificate is selected, the following items are configured:

Common Name The printer’s IP Address appears here.

Organisation Enter the name of your organisation.

Organisation Unit Optional. Allows you to enter a subdivision or department 
name.

Locality Enter the name of the city where the organization is located.

State/Province Enter the state or province where the organisation is located.

Country/Region Enter the country or region where the organisation is 
located.

Key Exchange Method Select RSA (the default) or Diffie-Hellman(DSS).

Key size Select 1024 (the default) or 2048 bits.
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IEEE802.1X Tab (Oki Device Setup)

> Setup by HTTP
Launches the default browser in your environment to access the selected printer’s 
web page.

> Setup by TELNET
Launches the TELNET application in your environment to access the selected 
printer’s TELNET port.

> Reset
Resets the selected network interface card.

> Test Print
Prints the network summary details (see page 9).

> IP Address Setup
Sets the static IP address of the network interface card manually. If you only use 
TCP/IP and the print server has not yet been configured, occasionally it may not be 

ITEM COMMENTS

Use IEEE802.1X Enable/disable

EAP Type The following items can be configured:

EAP-TLS Use EAP-TLS protocol

PEAP Use EAP-TLS protocol

Use SSL/TLS 
Certificate

Enable/disable

Authenticate server Enable/disable

Certificate Client certificate File:

Password:

Options to Import, Delete, View

CA certificate File:

Password:

Options to Import, Delete, View

NOTE
The TELNET application is not included as part of the print server package. 
Install the TELNET package on to your system. For further information, see 
your Windows manual.
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displayed on AdminManager. You can configure the IP address of the print server by 
this function.

(a) Enter the Ethernet Address (MAC Address) and the IP Address, then click 
OK.

(b) AdminManager asks whether you want to initialise the network interface card or 
not. Select Yes.

OPTION MENU

> Use TCP/IP Protocol
If this item is selected, AdminManager uses TCP/IP protocol to search/configure 
network interface cards.

> Use IPX/SPX Protocol
If this item is selected, AdminManager uses IPX/SPX protocol to search/configure 
network interface cards.

> Environment Setup
Set environment items such as broadcast addresses for TCP/IP protocol, network 
addresses for NetWare protocol and Time Out.

NOTE
The Ethernet (MAC) Address is displayed under “General Information” on the 
network summary printout (see page 9).

NOTE
Even if you select No here, the IP address that you set can be used after 
turning the printer OFF and ON. The requirement to turn your printer OFF and 
ON is dependent on the network interface card.
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TCP/IP Tab (Environmental Setup)

NetWare Tab (Environmental Setup)

ITEM COMMENTS

Use TCPP/IP 
Protocol

Enable/disable TCP/IP protocol.  The default is 
enabled. If disabled, the search will not be 
carried out using TCP/IP.

Set Broadcast 
Address

Set broadcast addresses that are used to search 
Oki network interface cards using the TCP/IP 
protocol.

Add Click Add to add the address to the list in the 
box.

Delete Select an address in the box, then click Delete 
to remove it.

ITEM COMMENTS

Use NetWare 
Protocol

Enable/disable NetWare protocol.  The default is 
enabled. If disabled, the search will not be 
carried out using NetWare.

Auto Search If Auto Search is selected (the default), 
AdminManager will search all networks that it 
can detect.

Set Network 
Number

Set network addresses that are used to search 
Oki network interface cards via NetWare 
protocol. If there any many NetWare file servers 
on your network, specify the network address to 
which the network card belongs.

Add Click to add the network number you have 
entered to the list box.

Delete Select a network number in the list box, then 
click Delete to remove it.
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SNMP Tab (Environmental Setup)

Timeout Tab (Environmental Setup)

HELP MENU

About
Provides software Version and copyright information.

ITEM COMMENTS

Obtain the 
printer name via 
SNMP

Enable/disable.

Community 
name

Set a community name.

Add Click to add the entry to the list box.

Delete Select an entry in the list box, then click Delete 
to remove it.

ITEM COMMENTS

Set Timeout: 
Printer Search

Search Every (20-180sec)
Set the response waiting time from the 
network card in seconds. Default is 30 
seconds.

Set Timeout:
Data Send/
Receive

Time Outs (1-60sec)
Set time out between AdminManager and the 
network interface card in seconds. Default is 5 
seconds.

Retry (1-5)
Sets how many times AdminManager will retry 
to transmit/receive data to/from the network 
interface card. Default is 3 retries.
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USING A WEB BROWSER
If the print server is connected to the network using TCP/IP, its settings and the printer 
menu settings can be configured using a Web browser.

LAUNCHING THE WEB BROWSER 

1. Have a copy of the network summary printout to hand (see page 9).

> The MAC address is listed under “General Information.” You will use the last six 
digits of the MAC Address (minus punctuation marks) as the password when 
logging in for the first time.

> The IP Address, Subnet Mask and Default Gateway are listed under “TCP/IP 
Configuration.”

2. Launch the Web browser.

3. Enter the print server’s IP Address.

4. Press the Enter key.

The Printer Status window displays.

5. To ensure correct operation, change the browser cache or temporary internet 
settings to ensure the latest version is viewed at each session. For example, using 
Internet Explorer:

(a) In the Tools pull-down menu, select Internet Options.

(b) On the General tab, under Temporary Internet files, click Settings….

(c) Under Check for newer versions of stored programs, select Every visit to 
the page.

(d) Click OK.

NOTE
The network addresses used in this manual are shown for example only. 
Network addresses used in your installation should be within in the 
appropriate address range and have the correct subnet mask for your network 
segment.

To apply configuration changes using a Web browser, you will be prompted for 
a username and password:

username = root

default password = the last six digits of the MAC address. Note the password 
is case sensitive, use uppercase.

NOTE
The following illustrations are from Microsoft Internet Explorer.

NOTE
You can also launch the web browser from within the AdminManager utility. 
To do this, highlight the appropriate print server, then click Setup > Setup 
by HTTP:

NOTE
If you change the window size of the browser immediately after changing the 
configuration, Security information may appear. Uncheck Display this 
message next time.
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6. Click OK.

7. Click Administrator Login.

The Connect to window displays.

8. Enter “root” for the User Name and your password—the default is the last six digits 
of the MAC address (case sensitive, use uppercase)—under Password.

9. Click OK.

10. Click Skip to navigate to the main menu page.

11. In the left column, click the category for which you wish to make changes.

12. When you are finished, click Submit to send the changes to the print server.

NOTE
For information on setting up security features using the web browser refer to 
the Security Guide.
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CHANGING THE PASSWORD

1. Open the browser and enter the IP Address for the print server, then login with your 
current password.

2. Click Security > Password Configuration.

3. Under Administrator(root/admin) Password Configuration, enter the new 
password, then enter it again under Confirm New Admin Password.

4. Click Submit to save the changes or Cancel to exit.

NOTE
Maximum 15 characters.
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USING TELNET

EXAMPLE TELNET CONFIGURATION

TELNET requires the print server to have a valid IP address configured. If the NIC already 
has an IP address configured, skip steps 1 to 3 below.

1. Use the PING command to confirm the connection with the network card.

Example

For IP address 172.168.20.127:

PING 172.168.20.127

If there is no reply, there is a problem with the configuration of the IP address (the 
IP address has been already set manually or by the DHCP/RARP server), or with the 
network. Reset the network interface card settings to the default and try to set a 
temporary IP address. If you still have the problem after resetting the network 
interface card, consult the network manager.

2. Login to the network card using TELNET.

Example

For IP address 172.168.20.127

TELNET 172.168.20.127

You should see a sequence similar to the following example:

Trying 172.168.20.127
Connected to 172.168.20.127
Escape character is ‘^]’.
EthernetBoard OkiLAN PRINTER".
login: root
‘root’ user needs password to login.
password:
User ‘root’ logged in.
No. MENU (level.1)
------------------------------------
 1:Status / Information
 2:Printer Config
 3:Network Config
 4:Security Config
 5:Maintenance
99:Exit setup
Please select (1-99)?

3. Enter the number of the item to be changed.

The details window for that item displays.

CAUTION!

Please ensure that a valid IP address for your network 
environment is used. Use of an incorrect IP address can cause 
serious problems on your network.

NOTE
The method of configuring commands may differ between workstations. Refer 
to the workstation’s manual.
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4. When the configuration is complete, click Exit Setup to save your change. To exit 
without saving your modification, select Quit.

5. Turn the printer off and on again.

NOTE
The network card continues to use pre-transmission settings until the printer 
is turned off and back on again.
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SECTION 2: UTILITIES
This section covers the following:

> “Management utility - PrintSuperVision (Windows only)” on page 36

> “Oki LPR printing utility (Windows only)” on page 37
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MANAGEMENT UTILITY - PRINTSUPERVISION (WINDOWS ONLY)

PrintSuperVision is a Windows application designed for managing and monitoring printing 
devices connected to a network. The core application is server-based and is accessible from 
any browser enabled device connected to the network.

For full details of how to install and use PrintSuperVision, please refer to the 
PrintSuperVision Configuration Guide which is available on the support website.

NOTE
Not all utilities, features or protocols are supported by every product. Please 
check with your User’s Guide and support website for latest information.



OKI LPR PRINTING UTILITY (WINDOWS ONLY)

Oki LPR is a utility that allows printing data to printers connected to the network via TCP/
IP. It is an alternative method of connecting printers instead of using the Microsoft TCP/IP 
port; however, the Oki LPR utility offers some additional and very useful features:

> Displays printer status - print job status can be viewed, paused or cancelled.

> Download files directly to the printer - send PRN or PostScript files directly to 
the printer.

> Redirect print jobs - send print jobs to other printers if the original printer is busy 
or has an error.

> Multicast printing - send the same print job to many printers simultaneously1.

SYSTEM REQUIREMENT

Operating systems with TCP/IP support and Oki printers that support TCP/IP.

INSTALLING THE OKI LPR UTILITY

1. Insert the CD/DVD-ROM into the CD/DVD-ROM drive. The Setup Utility starts 
automatically. If it does not start, double-click setup.exe on the CD/DVD-ROM.

2. Select the appropriate setup language and click I agree to accept the terms of the 
Software Licence Agreement.

3. Select Software Utilities > Install LPR utility.

4. In the Choose Setup Language dialog, select the appropriate language and click 
OK.

The Oki LPR utility is displayed.

5. Click Next.

6. Click Yes to accept the Software Licence Agreement.

7. Verify Destination Folder and Spool Folder and click Next.

8. Select Register in Startup if you want automatic startup as Windows boots up. 
Select Launch as minimized if you want to startup in the Icon state. Click Next.

9. Verify the program folder name and click Next.

The installation starts.

10. When the installation ends, the Setup complete screen is displayed. Check Yes, I 
want to launch Oki LPR Utility now and click Finish. 

11. Check Yes, I want to view the ReadMe File. 

The Oki LPR utility starts.

NOTE
Not all utilities, features or protocols are supported by every product. Please 
check with your User’s Guide and support website for latest information.

1. The printers all have to be of the same model.

NOTE
Some Operating Systems require administrator privileges in order to make 
changes.
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12. You may be asked whether it is OK to change write permissions for the spool 
directory. Click Yes to allow the utility to be correctly installed.

13. Select Remote Print > Add Printer.

14. Click Discover… to search for the IP address of a suitable machine on your 
network.

15. Highlight the machine you will use and click OK.

16. If your machine is not discovered, click Cancel and type the IP address directly at 
IP Address:.

17. Click OK. A machine is added to the main window.

Refer to the On-line Help for information on how to use the utility.

USING OKI LPR
Refer to the on-line Help for information on how to use the utility.

UNINSTALLING THE OKI LPR UTILITY

1. To exit the Oki LPR Utility, select File > Exit.

2. Select Start > Programs > Okidata > Oki LPR Utility > Uninstall Oki LPR 
Utility. 

You may find this under Start > All Programs on Windows XP.

3. Click Yes when the “Confirm File Deletion” dialog is displayed. 

Deletion of the Oki LPR utility starts.

4. You may be asked whether you want to remove shared files. Click Yes.

5. When the deletion has finished, the “Uninstall Successfully Completed” screen is 
displayed. Click OK.

If a file that has been added after installation exists in the folder to install the OkiLPR utility 
or the folder to spool, you cannot delete the folder. Delete any unwanted files before 
running Uninstall OkiLPR Utility.
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SECTION 3: PRINTING FROM WINDOWS
This section provides guidelines on how to print over the network from various Microsoft 
Windows operating systems. There are numerous ways of printing from Windows and the 
exact set-up will vary depending upon your environment. There are also numerous versions 
of Windows, which can be configured as either a client, server or both.

Although there are many variants of Windows, the principles of network printing are the 
same. Microsoft provides on-line help with all of their operating systems and this is a good 
reference point for the exact details of each configuration option within Windows.

The network printer supports TCP/IP protocols that can be used in conjunction with the 
Windows operating system.

NOTE
Not all utilities are supported by every operating system. Please check with 
your User’s Guide and your support website for latest information.
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INSTALLING A NETWORK PRINTER
There are two ways to set up a network printer:

> Install automatically, using the Oki Driver Installer

> Install it yourself using the Add Printer Wizard

USING THE OKI DRIVER INSTALLER

The Oki driver installer program searches for compatible printers on the network and 
installs and configures the printer drivers with the correct port settings automatically.

Using the Oki driver installer program, you can install to the following connected printer 
types:

> Locally connected printers

> USB port

> Parallel port

> Networked printers

> Directly connected (i.e. Peer-to-peer) printers via TCP/IP. The Microsoft Standard 
TCP/IP is installed and configured to use Port 9100 with the printer’s IP address.

> Printers not directly connected, but shared via a PC (i.e. Client-Server)

WHY USE THE OKI DRIVER INSTALLER?

> Automatically discovers printers on the network (TCP/IP)

> Installs driver and correctly assigns the appropriate port and IP address

> Allows easy configuration of sharing the printer with other network users 

> Automatically configures the printer drivers with the appropriate hardware device 
options such as hard disk drive, duplex unit (via Oki Network Extension software)

USING THE ADD PRINTER WIZARD

METHOD SUMMARY

The following table shows the different ways to connect to the printer (i.e. port types).

WINDOWS 2000 WINDOWS XP WINDOWS VISTA / 
WINDOWS7

Windows 
Rally

No No Yes

Windows 
Standard 
TCP/IP Port

Yes Yes Yes

OkiLPR Yes Yes No

IPP Yes Yes Yes

NetBEUI Yes Yes No
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ABOUT THE DIFFERENT METHODS

Windows Rally

Windows Rally is an automated “plug and play” type utility that allows users to discover 
and configure network devices effortlessly.

Windows standard TCP/IP port

The standard TCP/IP port simplifies connecting to remote printers using the TCP/IP 
protocol. A computer that acts as a print server must run the TCP/IP protocol in order to 
print.

You can configure this to use either LPR or Raw (e.g. Port 9100).

OkiLPR

Used to connect your printer over TCP/IP using an LPR port.

OkiLPR also includes useful tools enabling you to download PS and PRN files directly to your 
printer, and automatically redirect jobs to other printers on the network.

IPP

The IPP (Internet Printing Protocol), defines a standard protocol for printing as well as 
managing print jobs, media size, resolution, and such like.

NetBEUI

NetBEUI (NetBios Extended User Interface) is a protocol that was designed for use on small 
workgroups or LANs. Within Windows, NetBEUI is used for file and printer sharing between 
computers. It provides a simple method of printing, but the protocol does have limitations 
and is not as robust as TCP/IP or IPX. Typically it is employed in small business networks 
or home networks.
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SECTION 4: PRINTING USING MACOS
This section covers the following:

> “Overview” on page 43

> “Network summary printout” on page 44

> “MacOS printer setup utility” on page 45

> “Connecting to your printer” on page 52

> “Configuring printer hardware options” on page 57



Overview > 43

OVERVIEW
This guide is for administrators and it should be read in conjunction with the relevant 
Mac OS X manual.

To get the best results from your printer, install the Postscript Printer Description (PPD) file 
supplied with your printer and use this to customise the Apple PostScript driver that is built-
in to the OS X. Features provided by the PPD file includes:

> Supported paper types

> Paper trays

> Printer resolution

> Printer colour matching

SETTING UP A NETWORK PRINTER

1. If the printer does not already have an IP address, use the Printer Setup Utility to 
assign an IP address. See “The printer setup utility interface” on page 46.

To do this, you will need to know the printer's MAC address. This can be found on the 
print server's network summary printout. See “Network summary printout” on 
page 44.

2. Install the printer driver software. This copies the printer driver files to the correct 
location on your Mac OS X system.

3. Make a connection to the printer by USB, TCP/IP, Bonjour or AppleTalk. See 
“Connecting to your printer” on page 52.

4. If required, enable hardware device options such as duplex unit or printer hard disk. 
See “Configuring printer hardware options” on page 57.

NOTE
> The PPD file must be installed using the Oki Driver Installer to ensure that 

all essential files are copied.

> Not all utilities, features or protocols are supported by every operating 
system. Please check with your support website for the latest information.
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NETWORK SUMMARY PRINTOUT
The printer’s configuration page reports information that is required for Macintosh 
configuration. Refer to “Network summary printout” on page 9 for details on how to print 
a configuration map.

The first six characters of the Ethernet address are the same for all OkiLAN type network 
cards. The last six characters of the Ethernet address are unique to each card.



MACOS PRINTER SETUP UTILITY
The Printer Setup Utility is a powerful MacOS-based utility for configuring all print server 
functions using a graphical user interface. 

INSTALLING THE PRINTER SETUP UTILITY

1. Insert the Network & Utilities CD/DVD into the CD/DVD-ROM drive.

2. Open the Printer Setup Utility folder and double-click Installer.

3. Select the destination directory, then click Next.

4. Ensure the Yes option is selected to activate the utility, then click Finish.
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THE PRINTER SETUP UTILITY INTERFACE

The Printer Setup Utility auto-discovers Oki compatible network cards.

1. Select the correct printer NIC to configure, click Setup menu then choose Oki 
Device Setup.

2. At the prompt, enter the Admin password.

3. Select the TCP/IP tab and assign your printer’s IP address.

4. Click Apply.

MENU OPTIONS

DISCOVER PRINTERS

Locates and lists all printers in your network which have an Oki compatible network 
card installed.

PRINTER STATUS MONITOR

Displays the current status of the printer.

NOTE
The default admin password is the last six digits of the MAC Address, minus 
any punctuation marks. e.g., for a MAC (Ethernet) Address of 
00:80:87:A4:55:79, the password would be A45579.
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PRINTER NIC CARD SUMMARY/SYSTEM STATUS

Displays the network card summary details.

CHANGE SETTINGS/OKI DEVICE SETUP

Use this to configure the network card settings (requires Admin password).

General Tab

The General tab allows you to change the admin password.

1. Click Change.

2. Enter the current value, then enter the new value and re-enter it under Confirm ….

3. Click OK.

4. Click Apply.

NOTE
The default admin password is the last six digits of the MAC Address, minus 
any punctuation marks. e.g., for a MAC (Ethernet) Address of 
00:80:87:A4:55:79, the password would be A45579.
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TCP/IP Tab 

Netware Tab 

ITEM COMMENTS 

Use TCP/IP Protocol Enable/disable TCP/IP protocol.

Use DHCP/BOOTP Click to select this item if the IP address, subnet mask, 
default gateway and IP addresses for DNS primary server 
and secondary servers are retrieved from the DHCP or 
BOOTP server.

IP Address Set the IP address of the selected network interface card.

Subnet Mask Set the subnet mask of the selected network interface card. 

Default Gateway Set the default gateway of the selected network interface 
card. 

Use IPv6 Function Use to enable/disable IPv6.

ITEM COMMENTS

Use NetWare Protocol Enable/disable NetWare protocol.

Print Server Name Set a Print Server name.

Frame Type Set the primary NetWare frame type.

Operation Mode Select the NetWare mode:

PSERVER Mode (the default)

RPRINTER Mode
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EtherTalk Tab 

Bindery Setup Configure Bindery mode items, including:

File Server to be 
connected.

Specify up to 8 file 
servers to connect. 

Password. Set a password for the 
Print Server.

Job Polling Time Set the print job polling 
interval in seconds.

NDS Setup Set the NDS Tree and Context where the Print 
Server was created.

Printer Name Set the NetWare printer object name.

ITEM COMMENTS

Use EtherTalk 
Protocol

Enable/disable EtherTalk protocol.

Printer Name Set the EtherTalk Printer object name.

Zone Name Set the name of the zone to which the print server belongs.

ITEM COMMENTS
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NetBEUI Tab

SNMP Tab 

OPEN WEB BROWSER/CONFIGURATION VIA HTTP

Displays the printer web page.

CHANGE UTILITY PREFERENCES/ENVIRONMENT SETUP

Use this to configure the utility preferences for broadcast addresses for TCP/IP 
protocol and Time Out.

ITEM COMMENTS

Use NetBEUI Protocol Enable/disable NetBEUI protocol.

Short Printer Name Set a name for the print server.

Workgroup Set a name for the work group to which the 
print server  belongs.

Comment Set the comments for the print server.

ITEM COMMENTS

SysContact Set the printer manager name.

SysName Set the printer model name. 

SysLocation Set the location where the printer is installed.
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TCP/IP Tab (Environmental Setup)

Timeout Tab (Environmental Setup)

ITEM COMMENTS

Set Broadcast Address Set broadcast addresses that are used to search Oki 
network interface cards using the TCP/IP protocol.

Add Click Add to add the address to the list in the box.

Delete Select an address in the box, then click Delete to 
remove it.

ITEM COMMENTS

Set Timeout: Printer 
Search

Search Every (20-180sec)
Set the response waiting time from the network card 
in seconds. Default is 30 seconds.

Set Timeout:
Data Send/Receive

Time Outs (1-60sec)
Set time out between AdminManager and the 
network interface card in seconds. Default is 5 
seconds.

Retry (1-5)
Sets how many times AdminManager will retry to 
transmit/receive data to/from the network interface 
card. Default is 3 retries.
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CONNECTING TO YOUR PRINTER

SNOW LEOPARD (10.6) AND LEOPARD (10.5)

USB

1. Choose Apple Menu > System Preferences > Print & Fax.

2. If the printer is already in the list of printers, click “-” to remove it.

3. Click “+” to add a new printer.

4. Ensure the Default tab is selected and select your printer from the list.

> >Your printer is displayed as type USB in the list of available printers.

> >Ensure that the Print Using: selection matches your printer. If Generic 
PostScript Printer is displayed, select a driver that matches.

5. Click Add.

6. Click Configure... and ensure the hardware options displayed match your 
printer.The printer is added to the list of printers.

7. Restart your computer.

BONJOUR

1. Choose Apple Menu > System Preferences > Print & Fax.

2. Click “+”.

3. Select your printer model from the Default Browser.

4. Click Add….

5. Depending on the connection type, you may be prompted to configure any additional 
printer hardware options. If your printer has options such as a storage device or 
second tray, switch on the relevant options.

APPLETALK (LEOPARD ONLY)

1. Choose Apple Menu > System Preferences > Print & Fax.

2. Click “+”.

3. Select your printer model from the Default Browser.

4. Click Add….

5. Depending on the connection type, you may be prompted to configure any additional 
printer hardware options. If your printer has options such as a storage device or 
second tray, switch on the relevant options.

TCP/IP CONNECTION

1. Choose Apple Menu > System Preferences > Print & Fax.

2. Click “+”.

3. Click the IP Printer button.

4. From the Protocol menu, choose Line Printer Daemon – LPD.

NOTE
AppleTalk is not supported in snow Leopard.
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5. Enter the printer's IP address in Address.

To find the printer's IP address, you can print a configuration page from the printer's 
operator panel. Refer to “Network summary printout” on page 9.

6. Check the correct PPD file for your printer is selected in the Print Using menu.

7. Click Add.

8. You will be prompted to configure any additional printer hardware options. If your 
printer has options such as a storage device or second tray, switch on the relevant 
options.

TIGER (10.4)

BONJOUR, APPLETALK OR USB

1. Launch Printer Setup Utility

This is located in the Applications > Utilities folder.

2. Click Add….

3. Select your printer model from the Default Browser.

4. Click Add.

Depending on the connection type, you may be prompted to configure any additional 
printer hardware options. If your printer has options such as a hard disk or second 
tray, switch on the relevant options.

5. Quit Printer Setup Utility.

TCP/IP CONNECTION

1. Launch Printer Setup Utility

This is located in the Applications > Utilities folder.

2. Click Add….

3. Click the IP Printer button.

4. From the Protocol menu, choose Line Printer Daemon – LPD.
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5. Enter the printer’s IP address in Address.

To find the printer’s IP address, you can print a configuration page from the printer 
operator panel. Refer to “Network summary printout” on page 9.

6. Check the correct PPD file for your printer is selected in the Print Using menu.

7. Click Add….

8. You will be prompted to configure any additional printer hardware options. If your 
printer has options such as a hard disk or second tray, switch on the relevant 
options.

9. Click Continue.

10. Quit Printer Setup Utility.

PANTHER (10.3)

RENDEZVOUS

If you have not already done so, run the Oki software installer before following the steps 
below.

1. Start the Printer Setup Utility.

This is located in the Applications > Utilities folder.

2. Click Add....

3. From the pop-up menu, choose Rendezvous.

4. Select the printer to connect to.

5. Click Add.

6. Click the Printer Setup Utility menu, and choose Quit Printer Setup Utility.

After adding the printer, you should configure printer hardware options. Refer to 
“Configuring printer hardware options” on page 57.

NOTE
If your printer is already listed, your Mac may already have discovered the 
printer before you installed the Oki software. In this case, the printer may be 
using the incorrect PPD file or may not have the correct hardware options 
configured. You should delete the printer, quit Printer Setup Utility, and re-
launch the utility before continuing.
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IP CONNECTION

If you have not already done so, run the Oki software installer before following the steps 
below.

1. Start the Printer Setup Utility.

This is located in the Applications > Utilities folder.

2. Click Add....

3. Click the pop-up menu and choose IP Printing.

4. Click the Printer Type menu and choose LPD/LPR.

5. Enter the printer's IP address.

To find the printer’s IP address, you can print a configuration page from the printer’s 
operator panel:

(a) Press the Menu keys until PRINT INFORMATION is displayed.

(b) Press the Enter button.

(c) Press the Menu keys until CONFIGURATION is displayed.

(d) Press the Enter button.

(e) Confirm that EXECUTE is displayed, then press the Enter button.

The Configuration pages are printed. The printer’s IP address is shown under 
the Network section on the left-hand side of the first sheet.

6. Enter the queue name. If you do not know the queue name, leave it as Use Default 
Queue on Server.

7. Click the pop-up menu and choose your printer model.

8. Click Add.

9. Click the Printer Setup Utility menu, and choose Quit Printer Setup Utility.

After adding the printer, you should configure printer hardware options. Refer to 
“Configuring printer hardware options” on page 57.

APPLETALK CONNECTION

If you have not already done so, run the Oki software installer before following the steps 
below.

1. Start the Printer Setup Utility.

This is located in the Applications > Utilities folder.

2. Click Add....

3. From the pop-up menu, choose AppleTalk.

4. Choose a printer to connect to.

5. Click Add.

6. Click the Printer Setup Utility menu, and choose Quit Printer Setup Utility.

NOTE
If your printer is already listed, your Mac may already have discovered the 
printer before you installed the Oki software. In this case, the printer may be 
using the incorrect PPD file or may not have the correct hardware options 
configured. You should delete the printer, quit Printer Setup Utility, and re-
launch the utility before continuing.
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USB CONNECTION

If you have not already done so, run the Oki software installer before following the steps 
below.

1. Start the Printer Setup Utility.

This is located in the Applications > Utilities folder.

2. Click Add Printer....

3. From the pop-up menu, choose USB.

4. Choose a printer to connect to.

5. Click Add.

6. Click the Printer Setup Utility menu, and choose Quit Printer Setup Utility.

NOTE
If your printer is already listed, your Mac may already have discovered the 
printer before you installed the Oki software. In this case, the printer may be 
using the incorrect PPD file or may not have the correct hardware options 
configured. You should delete the printer, quit Printer Setup Utility, and re-
launch the utility before continuing.
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CONFIGURING PRINTER HARDWARE OPTIONS

If you have added additional hardware, for example additional paper trays, to your printer 
these must be enabled in the printer driver.

1. Start the Printer Setup Utility.

This is located in the Applications > Utilities folder.

Ensure that your printer model is selected.

2. Click the Printers menu, and choose Show Info.

3. From the popup menu, select Installable Options.

4. Select any options appropriate to your hardware, and click Apply Changes.

NOTE
Applies to IP and Rendezvous network connections only.
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SECTION 5: TROUBLESHOOTING

This section covers the following:

> “Network summary printout” on page 59

> “TCP/IP” on page 60

> “NetBEUI” on page 61

> “Mac” on page 62

> “Web browser” on page 63

NOTE
The network addresses used in this manual are shown for example only. 
Network addresses used in your installation should be within in the 
appropriate address range and have the correct subnet mask for your network 
segment.
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NETWORK SUMMARY PRINTOUT

NETWORK SUMMARY DOES NOT PRINT

Ensure the printer emulation is set to PS (if available) or Automatic.

AN ERROR IS PRINTED IN THE NETWORK SUMMARY

> Confirm that the NIC is installed correctly and turn the printer off and on again.

> Ensure the network cable is correctly connected.

> Connect to a different network segment, re-print the summary and see if this fixes 
the problem.

EEPROM CHECK REGISTERS AN ERROR

> Confirm that the NIC is installed correctly and turn the printer off and on again.

> Initialise the NIC.
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TCP/IP

PRINTER CANNOT FIND THE NETWORK INTERFACE CARD

> Turn the printer off for 15 seconds and then on again.

> Confirm that the network interface is enabled on the printer.

> Make sure there is a response to the ping command.

> Make sure the network cable is correctly connected and that the green LED close to 
the printer’s network interface is lit. If not, change the cable and try again.

> Run the Self-diagnostic test (with printer on, press and hold the Test button on the 
print server for 3 seconds, then release it). 

> Make sure that the IP Address, Subnet Mask and Gateway are correct. 

> Make sure that the TCP/IP protocol is set to Enable.

> Reset the network interface card to the factory default settings.

> If DHCP, BOOTP and RARP are not used, ensure they have been set to Disable.

CANNOT PRINT WITH LPR AND FTP

> Turn the printer off for 15 seconds and then on again.

> Make sure there is a response to the ping command.

> Make sure the network cable is correctly connected.

> Change the cable and try again.

> Make sure the host name and IP address are configured in the workstation.

> Make sure the printer port name is configured in the workstation.

> There are three port names: lp, euc and sjis. Use lp by default as euc and sjis are 
specific to printers with PostScript available.

INCORRECT USER NAME ON THE BANNER PAGE

If printing with lpr, the user name printed is unknown and the Filename printed is the Spool 
file name.

If printing with FTP, the user name printed is the user name entered during FTP login and 
the file name printed is the transmitted file name. If the print directory name is indicated 
in the put command, the file name is not printed. The printer name printed is the logical 
directory name.
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NETBEUI

THE NETWORK INTERFACE CARD IS NOT IDENTIFIED

> Turn the printer off for 15 seconds and then on again.

> Make sure the network cable is correctly connected. 

> Change the cable and try again.

> Make sure that Microsoft network client and NetBEUI have been added to the 
network section of the control panel.

> Make sure the NetBEUI protocol is set to Enable.

> Make sure the factory setting of the workgroup name is PrintServer and the 
computer name is ML+ the last six digits of the MAC address.

> Make sure the computer name of the NIC is different from the computer name on 
the network. 

ERROR WRITING TO PRN1
> Make sure the printer is online.

> If there is an error message indicating the paper has run out, add more paper and 
cancel the error.

> Check whether another user is printing. Print after the other user has finished.
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MAC

BLANK PAGES OR GARBLED TEXT PRINTED

Symptoms:

When printing via a USB or TCP/IP connection, you receive blank pages or pages printed 
with a line of garbled text.

Cause:

This issue is normally caused by the data being sent to the printer in binary format. The 
printer may not be able to understand data in this format, and therefore may print blank 
pages or garbled text.

Solution:

In your application’s print options, there may be an option to send data as ASCII. Choose 
this option, and print your document.

For example, in Adobe Photoshop 7 or Adobe Photoshop CS: 

1. Click the File menu and select Print with Preview. 

2. Click the box Show More Options.

3. From the pop-up menu, choose Output.

4. From the pop-up menu Encoding, choose ASCII.

NO PRINTING OR PRINT QUEUE STOPPED

Symptoms:

Upon sending a job to the printer, the job disappears completely and is not printed, or the 
job remains stalled in Printer Setup Utility (Print Center).

Cause:

The Oki printer PostScript Printer Description (PPD) file has a dependency on a filter file. 
This filter file must be installed the following location:

/usr/libexec/cups/filter/OkfilterA

If this file is deleted, or is not present on your computer, jobs will not be sent to the printer 
at all. This can happen if you deleted this filter file or if you copied a PPD file from another 
Mac and did not use the Oki Software installer.

Solution:

Run the Oki printer software installer contained on the CD-ROMs that were supplied with 
your printer. This will install the CUPS filter file and allow normal printing.
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WEB BROWSER
If you find that the most recent settings are not shown on the printer web pages, you 
should temporarily switch off your browser's page caching. To prevent your web browser 
caching the printer web pages, carry out the following steps as appropriate for your web 
browser.

MICROSOFT INTERNET EXPLORER

1. Select Tools > Internet Options.

2. Select the General tab and, in Temporary Internet files, click Settings.

3. Under Check for newer versions of stored pages, select Every visit to the 
page.

4. Click OK.

MOZILLA FIREFOX

1. In the Firefox address bar, type about:config.

2. In the Filter field, type frequency.

3. Double click on the entry browser.cache.check_doc_frequency.

4. Change the Value to 1.

> 0: Check once per browser session

> 1: Check every time I view the page

> 2: Never check (always use cached page)

> 3 (default): Check when the page is out of date (automatically determined)

5. Click OK.

NOTE
Keeping this setting enabled all the time may slow down web browsing. You 
may want to revert back to the browser default setting once you have finished 
using the printer web page.



APPENDIX: THE PRINTER MENU

MENU BASICS

TOP LEVEL FUNCTIONS

The top-level Functions menus are: 

> Configuration (refer to Appendix B in the User’s Guide)

> Print Information (refer to Appendix B in the User’s Guide)

> Print Secure Job (refer to Appendix B in the User’s Guide)

> Menus (refer to Appendix B in the User’s Guide)

> Admin Setup: password protected (see page 70)

> Calibration (see page 81)

> Print Statistics: password protected (see page 83)

SPECIAL MENU

Boot Menu (see page 83)

OVERVIEW

The following tables summarise the Admin Setup, Calibration, Print Statistics and BootMenu 
trees.

The remainder of the menus above are described in Appendix B of the on-line printer User’s 
Guide.

TABLE CONVENTIONS USED

> The menu trees are given to the lowest menu item level. Typically, this can be a 
parameter that can be set by selecting from a range of values provided or a 
command that can be executed to display or print a status or setting value.

> Emboldened values are the defaults.

> Certain menus and items associated with, for example, the Finisher appear only if 
the associated hardware is installed or under certain conditions, as specified.
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FUNCTIONS MENU TREE: ADMIN SETUP, 
CALIBRATION, PRINT STATISTICS

FUNCTION SUBMENU 1 SUBMENU 2

Admin Setup
(password 
protected)

Enter Password
(see page 70)

–

Network Setup
(see page 70)

TCP/IP
IP Version
NetBEUI
NetWare
EtherTalk
Frame Type
IP Address Set
IP Address
Subnet Mask
Gateway Address
Web
Telnet
FTP
SNMP
Network Scale
Hub Link Setting
Factory Defaults?

Print Setup
(see page 72)

Personality
Copies
Duplex
Binding
Job Offset
Output Bin
Finisher Setup
Media Check
Transparency Detect
Resolution
Toner Save Mode
Mono-Print Speed
Default Orientation
Form Length
Edit Size
Trapping
X Dimension
Y Dimension

PS Setup
(see page 74)

Network Protocol
Parallel Protocol
USB Protocol
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Admin Setup 
(cont.)

PCL Setup
(see page 74)

Font Source
Font Number
Font Pitch
Font Height
Symbol Set
A4 Print Width
White Page Skip
CR Function
LF Function
Print Margin
True Black
Pen Width Adjust
Tray ID#

IBM PPR Setup
(see page 76)

Character Pitch
Font Condense
Character Set
Symbol Set
Letter O Style
Zero Character
Line Pitch
White Page Skip
CR Function
LF Function
Line Length
Form Length
TOF Position
Left Margin
Fit to Letter
Text Height
Continuous Paper Mode

EPSON FX Setup
(see page 78)

Character Pitch
Character Set
Symbol Set
Letter O Style
Zero Character
Line Pitch
White Page Skip
CR Function
Line Length
Form Length
TOF Position
Left Margin
Fit to Letter
Text Height
Continuous Paper Mode

Color Setup
(see page 79)

Ink Simulation
UCR
CMY 100% Density
CMYK Conversion

Memory Setup
(see page 79)

Receive Buffer Size
Resource Save

Flash Memory Setup
(see page 79)

Initialize
Resize PS Area

HDD Setup
(see page 80)

Initialize
Resize Partition
Format Partition

System Setup
(see page 80)

Near Life LED

Change Password
(see page 80)

New  Password
Verify Password

FUNCTION SUBMENU 1 SUBMENU 2
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Admin Setup 
(cont.)

Settings
(see page 80)

Reset Settings
Save Settings
Restore Settings

Calibration
(see 
page 81)

Auto Density Mode On
Off

Auto BG Adjust 
Mode

Off, -1, 0, +1, +2

Adjust Density Execute

Adjust Registration Execute

Heavy Media Adjust Off
-5
-4
-3
-2
-1
0
+1
+2
+3
+4
+5

Print Tuning Pattern Execute

Cyan Tuning Highlight
Mid-Tone
Dark

Magenta Tuning Highlight
Mid-Tone
Dark

Yellow Tuning Highlight
Mid-Tone
Dark

Black Tuning Highlight
Mid-Tone
Dark

Cyan Darkness 0, +1, +2, +3, -3, -2, -1

Magenta Darkness 0, +1, +2, +3, -3, -2, -1

Yellow Darkness 0, +1, +2, +3, -3, -2, -1

Black Darkness 0, +1, +2, +3, -3, -2, -1

Print 
Statistics
(see 
page 83)

Enter Password –

Statistics Log Enable
Disable

Log Size 1 ~ 30 ~ 100

Reset Counter Execute

Change Password –

New Password –

Verify Password –

FUNCTION SUBMENU 1 SUBMENU 2
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BOOT MENU TREE

PRINTER MENU: MAKING CHANGES IN THE MENU

MAKING CHANGES IN THE FUNCTION MENU

1. Ensure that the LCD panel indicates that the printer is ready to print.

2. Press the Enter button to switch to the Menu mode.

3. Press the Up-arrow or Down-arrow buttons to scroll down to the Function you 
wish to change, then press the Enter button.

4. Continue to use the Up-arrow, Down-arrow and Enter buttons in a similar 
manner to drill down to the item you wish to change.

5. Use the Up-arrow or Down-arrow buttons to scroll down to the setting you wish to 
engage, then press Enter.

An asterisk (*) appears next to the new setting.

6. Press the Online button to exit menu mode and return to the Ready to print status.

CATEGORY ITEM

Parallel Setup
(see page 84)

Parallel
Bi-Direction
ECP
Ack Width
ACK Busy Timing
I-Prime
Offline Receive

USB Setup
(see page 84)

USB
Speed
Soft Reset
Offline Receive
Serial Number

Security Setup
(see page 85)

Job Limitation
Reset Cipher Key

Storage Setup
(see page 85)

Check File System
Check All Sectors
Enable HDD
Erase HDD
Enable Initialization

Power Setup
(see page 86)

Peak Power Control
Power Save
Moisture Control

Language Setup
(see page 86)

Language Initialize

Security Setup
Storage Setup

USB Setup
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Example: Enabling FTP

1. Ensure that the LCD panel indicates that the printer is ready to print.

2. Press the Enter button to switch to the Menu mode.

3. With Configuration highlighted, press the Enter button to select this menu.

4. Press the Up-arrow or Down-arrow buttons repeatedly until Admin Setup is 
highlighted.

5. Press the Enter button to select this item.

6. Press the Up-arrow or Down-arrow buttons to enter the first digit of the 
password, then press the Enter button.

7. Repeat the previous step for each digit of the password.

8. Press the Enter button to go into the Admin Setup menu.

9. With Network Setup highlighted, press the Enter button.

10. Press the Up-arrow or Down-arrow buttons repeatedly until FTP is highlighted.

11. Use the Up-arrow or Down-arrow buttons to highlight Enable.

12. Press the Enter button to engage the setting.

An asterisk (*) appears next to the new setting.

13. Press the Online button to exit menu mode and return to the Ready to print status.

MAKING CHANGES IN THE BOOT MENU

1. Turn the printer OFF.

2. Press and hold the Enter button while turning the printer back on.

3. Use the Up-arrow or Down-arrow buttons to scroll to an entry and the Enter 
button to select the entry, until you reach the item you wish to change.

4. Use the Up-arrow or Down-arrow buttons to scroll down to the setting you wish to 
engage, then press the Enter button.

An asterisk (*) appears next to the new setting.

5. Press the Online button to exit menu mode and return to the Ready to print status.

NOTE
Keep pressing the Enter button until INITIALISING appears on the display.
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PRINTER MENU: FUNCTIONS LIST

ADMIN SETUP

Password 

Network setup

ITEM VALUE DESCRIPTION

Enter password ****** Enter a password to enter the Administrator menu.

The default password is aaaaaa.

ITEM VALUE DESCRIPTION

TCP/IP Enable
Disable

Enables/Disables the TCP/IP protocol.

IP Version IP v4
IP v4+v6
IP v6

Set up the IP Version.

Display condition: TCP/IP protocol must be enabled.

NetBEUI Enable
Disable

Enables/Disables the NETBEUI protocol.

NetWare Enable
Disable

Enables/Disables the NetWare protocol.

EtherTalk Enable
Disable

Enables/Disables the EtherTalk protocol.

Frame Type Auto
802.2
802.3
Ethernet II
SNAP

Sets the frame type (NetWare).

IP Address Set Auto
Manual

Sets IP address setup method (TCP/IP).

IP Address xxx.xxx.xxx.xxx Sets the IP address (TCP/IP).

Subnet Mask xxx.xxx.xxx.xxx Sets the Subnet Mask (TCP/IP).

Gateway Address xxx.xxx.xxx.xxx Sets the Gateway (default router) address (TCP/IP).

Web Enable
Disable

Enables/Disables the Web/IPP (TCP/IP).

Telnet Enable
Disable

Enables/Disables Telnet (TCP/IP).

FTP Enable
Disable

Enables/Disables FTP (TCP/IP).

SNMP Enable
Disable

Enables/Disables SNMP of FTP (TCP/IP or NetWare).

Network Scale Normal
Small

Normal: Can work effectively even when connected 
to a HUB that has a spanning tree feature. However, 
printer start up time gets longer when computers are 
connected to two or three small LANs.

Small: Computers can cover from two or three small 
LANs to a large LAN, but it may not work effectively 
when it is connected to a HUB with a spanning tree 
feature.
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Hub Link Setting Auto 
Negotiate

1000Base-T Full
100Base-TX Full 
100Base-TX 
Half 
10Base-T Full
10Base-T Half

Sets the hub linking method.

Factory Defaults? Execute Specifies whether to initialise the network menu.

ITEM VALUE DESCRIPTION
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Print setup

ITEM VALUE DESCRIPTION

Personality Auto
PostScript
PCL
IBM PPR
EPSON FX

Selects a printer language.

Copies 1 ~ 999 Sets number of copies. Disabled for 
local print, except for demo data.

Duplex On
Off

Specifies duplex printing.

Binding LongEdge
ShortEdge

Specifies how to bind duplex 
printing.

Job Offset On
Off 

Enables/Disables Job offset.

Output Bin Face Down
Face Up

Specifies where to eject prints.

Face Down
Finisher

Specifies where to eject prints when 
a Finisher is installed.

Finisher Setup
This appears only if the optional finisher is installed. See the documentation supplied 
with the finisher for information on setting it up.

Media Check Enable
Disable

Enables/Disables whether the printer 
checks that paper size required by 
the print data matches that of the 
tray. Only standard sizes can be 
checked.

Transparency 
Detect

Auto
Disable

Enables/Disables the automatic 
detection of transparencies. (Use it 
while detecting sensor mistakes).

Resolution 600dpi
600x1200dpi
600dpi multi-level

Sets the resolution.

Toner Save 
Mode

ON
OFF 

Sets toner saving mode.

Mono-Print 
Speed

Auto
Color Speed
Normal Speed

Sets the monochrome print speed.
Auto: prints at most appropriate 
speed for page.
Color Speed: always prints at colour 
speed.
Normal Speed: always prints at 
monochrome speed.

Default 
Orientation

Portrait
Landscape 

Sets printing orientation (only for 
PCL, IBMPPR, EPSONFX). Invalid for 
PS.

Form Length 5 ~ 60 (L) ~ 64 (A) ~ 
128 lines

Sets the number of lines printable on 
one page (only for PCL). Invalid for 
PS.
The emboldened default values given 
are for Letter (L) and A4 (A). In 
practice, the values change 
corresponding to the size of paper in 
the tray.
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Edit Size Cassette size
Letter Short Edge
Letter Long Edge
Executive
Legal14
Legal13.5
Legal13
Tabloid Extra
Tabloid
A3Nobi
A3Wide
A3
A4 Short Edge
A4 Long Edge
A5
A6
B4
B5 short edge
B5 long edge
Custom
Com-9 Envelope
Com-10 Envelope 
Monarch Envelope
DL Envelope 
C5
C4
Index Card

Specifies the size of an area to draw 
when there is no specification of a 
size by predefined paper edit size 
command from a host PC (only valid 
for PCL). Invalid for PS.

Trapping Off
Narrow
Wide

Sets trapping.

X Dimension 76 ~ 210 ~ 328 mm 
(3.0 ~ 12.9 inch)

Sets default Custom paper width, 
perpendicular to the direction of 
motion of paper.

Y Dimension 90 ~ 297 ~ 1200 mm
(3.5 ~ 47.2 inch)

Sets default Custom paper length, in 
the same direction as the direction of 
motion of paper.

ITEM VALUE DESCRIPTION
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PS setup  

PCL setup

ITEM VALUE DESCRIPTION

Network 
Protocol

ASCII
RAW

Specifies PS transmission protocol for network 
data. It does not appear for Non-PS type.

Parallel Protocol ASCII
RAW

Specifies PS transmission protocol for Centronics 
data. It does not appear for Non-PS type.

USB Protocol ASCII
RAW

Specifies PS transmission protocol for USB data. 
It does not appear for Non-PS type.

ITEM SUBMENU 
ITEM

VALUE DESCRIPTION

Font Source Resident
Resident2
Downloaded

Specifies the location of the 
PCL default font. 
RESIDENT2: displayed only 
when Heisei Font is installed. 
DOWNLOADED: displayed 
when software font is 
downloaded to RAM as 
permanent designation. 
Fonts downloaded to Flash 
and HDD by PJL command 
are not displayed in this 
menu.

Font Number 10
C0
S1

Sets the PCL font number.

Font Pitch 0.44 ~ 10.00 ~ 99.99 CPI Sets the width of the PCL 
default fonts.

Font Height 4.00 ~12.00 ~ 999.75 
point

Sets the height of the PCL 
default font.

Symbol Set PC-8, PC-8 Dan/Nor, PC-8 TK, PC-775, PC-850, PC-852, PC-
855, PC-857 TK, PC-858, PC-864L/A, PC-866, PC-869, PC-
1004, Pi Font, Plska Mazvia, PS Math, PS Text, Roman-8, 
Roman-9, Roman Ext, Serbo Croat1, Serbo Croat2, Spanish 
Ukrainian, VN Int'l, VN Math, VN US, Win 3.0, Win 3.1 Blt, 
Win 3.1 Cyr, Win 3.1 Grk, Win 3.1 Heb, Win 3.1 L1, Win 3.1 
L2, Win 3.1 L5, Wingdings Dingbats MS, Symbol, OCR-A, 
OCR-B, HP ZIP, USPSFIM, USPSSTP, USPSZIP, Bulgarian, 
CWI Hung DeskTop, German, Greek-437, Greek-437 Cy, 
Greek-737, Greek-928, Hebrew NC, Hebrew OC, IBM-437, 
IBM-850, IBM-860, IBM-863, IBM-865, ISO Dutch, ISO L1, 
ISO L2, ISO L5, ISO L6, ISO L9, ISO Swedish1, ISO 
Swedish2, ISO Swedish3, ISO-2 IRV, ISO-4 UK, ISO-6 ASC, 
ISO-10 S/F, ISO-11 Swe, ISO-14 JASC, ISO-15 Ita, ISO-16 
Por, ISO-17 Spa, ISO-21 Ger, ISO-25 Fre, ISO-57 Chi, ISO-
60 Nor, ISO-61 Nor, ISO-69 Fre, ISO-84 Por, ISO-85 Spa, 
Kamenicky, Legal, Math-8, MC Text, MS Publish, PC Ext D/N, 
PC Ext US, PC Set1, PC Set2 D/N , PC Set2 US, WIN3.1J

A4 Print Width 78 column
80 column

Sets line width subject to 
Auto LF with A4 paper in PCL.

White Page Skip ON
OFF

Sets to eject a page with 
non-print data (blank page) 
on receipt of the FF 
command (0CH) in PCL.
Set to OFF for ejection.
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CR Function CR
CR+LF

Sets the operation on receipt 
of a CR code in PCL.
(NL means new line).

LF Function LF
LF+CR

Sets the operation on receipt 
of a LF code in PCL.
(NL means new line).

Print Margin Normal 
1/5 inch 
1/6 inch

Sets the margin for paper 
printable area.

True Black ON
OFF

Sets use in PCL of Composite 
Black (mixed colour of CMKY) 
or Pure Black (only K) for 
black (100%). 
OFF: Sets Composite Black. 
ON: Sets Pure Black. 
Invalid for PS.

Pen Width Adjust ON
OFF

The thinnest line width in 
PCL, a 1-dot line, may look 
broken. 
ON: when the thinnest line 
width is specified, line width 
is emphasized to look wider. 
OFF: the line appears as 
specified.

Tray 
ID#

Tray2

Tray3

Tray4

Tray5 

1 ~ 5 ~ 59 

1 ~ 20 ~ 59

1 ~ 21 ~ 59 

1 ~ 22 ~ 59

Sets the number to specify 
Tray2, Tray3, Tray4, and 
Tray5 for the paper feed 
destination command in 
PCL5e emulation.

 MP Tray 1 ~ 4 ~ 59 Sets the number to specify 
MP Tray for the paper feed 
destination command in 
PCL5e emulation.

ITEM SUBMENU 
ITEM

VALUE DESCRIPTION
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IBM PPR setup 

ITEM VALUE DESCRIPTION

Character Pitch 10CPI
12CPI
17CPI
20CPI
Proportional

Sets the character pitch.

Font Condense 12CPI to 20CPI
12CPI to 12CPI

Sets the 12CPI pitch for 
Condensed printing mode.

Character Set SET-2
SET-1

Sets the character set to be 
used.

Symbol Set IBM-437, IBM-850, IBM-860, IBM-863, IBM-865, PC Set1, PC Ext 
US, PC Ext D/N, PC Set2 US, PC Set2 D/N, Roman-8, ISO L1, 
PC-8, PC-8 Dan/Nor, PC-850, Legal, ISO-2 IRV, ISO-4 UK, ISO-6 
ASC, ISO-10 S/F, ISO-11 Swe, ISO-14 JASC
ISO-15 Ita. ISO-16 Por. ISO-17 Spa. ISO-21 Ger. ISO-25 Fre. 
ISO-57 Chi. ISO-60 Nor, ISO-61 Nor, ISO-69 Fre, ISO-84 Por, 
ISO-85 Spa, German, Spanish, ISO Dutch, Roman Ext, ISO 
Swedish1, ISO Swedish2, ISO Swedish3, VN Math, VN Int'l, VN 
US, PS Math, PS Text, Math-8, Pi Font, MS Publish, Win 3.0, 
DeskTop, Win 3.1 L1, MC Text, PC-852, Win 3.1 L5, Win 3.1 L2, 
CWI Hung, PC-857 TK, ISO L2, ISO L5, PC-8 TK, Kamenicky, 
Hebrew NC, Hebrew OC, Plska Mazvia, ISO L6, Win 3.1 Heb, Win 
3.1 Cyr, PC-866, Win 3.1 Grk, PC-869, PC-855, Greek-437, 
Greek-437 Cy, Greek-737, Greek-928, Serbo Croat2, Ukrainian, 
Bulgarian, PC-1004, Win 3.1 Blt, PC-775, Serbo Croat1, PC-858, 
Roman-9, ISO L9

Letter O Style Enable
Disable

Sets the letter O style.

Zero Character Normal
Slashed

Sets the 0 style.

Line Pitch 6LPI
8LPI

Sets the line pitch.

White Page Skip Off
On

Sets whether a blank sheet is 
ejected.

CR Function CR
CR+LF

Sets the action when the CR 
code is received.

LF Function LF
LF+CR

Sets the action when the LF 
code is received.

Line Length 80 column
136 column

Sets the number of characters 
per line.

Form Length 11 inch
11.7 inch
12 inch

Sets the paper length.

TOF Position 0.0 inch
0.1 ~ 1.0 inch

Sets the print position from the 
top edge of the paper.

Left Margin 0.0 inch
0.1 ~ 1.0 inch

Sets the print position from the 
left edge of the paper.

Fit to Letter Enable
Disable

Sets the print mode that fits 
print data equivalent to 11 inch 
(66 lines) into Letter size 
printable area.
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Text height Same
Diff

Sets character height.
Same: same height, regardless 
of CPI.
Diff: character heights vary 
according to CPI.

Continuous Paper 
Mode

On
Off

Sets the edit direction of paper 
supported by A3 printer to 
landscape.

ITEM VALUE DESCRIPTION
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Epson FX setup 

ITEM VALUE DESCRIPTION

Character Pitch 10CPI
12CPI
17CPI
20CPI
Proportional

Sets the character pitch.

Character Set SET-2
SET-1

Sets the character set to be 
used.

Symbol Set IBM-437, IBM-850, IBM-860, IBM-863, IBM-865, PC Set1, PC Ext 
US, PC Ext D/N, PC Set2 US, PC Set2 D/N, Roman-8, ISO L1, PC-8, 
PC-8 Dan/Nor, PC-850, Legal, ISO-2 IRV, ISO-4 UK, ISO-6 ASC, 
ISO-10 S/F, ISO-11 Swe, ISO-14 JASC, ISO-15 Ita, ISO-16 Por, 
ISO-17 Spa, ISO-21 Ger, ISO-25 Fre, ISO-57 Chi, ISO-60 Nor, ISO-
61 Nor, ISO-69 Fre, ISO-84 Por, ISO-85 Spa, German, Spanish, ISO 
Dutch, Roman Ext, ISO Swedish1, ISO Swedish2, ISO Swedish3, VN 
Math, VN Int'l, VN US, PS Math, PS Text, Math-8, Pi Font, MS 
Publish, Win 3.0, DeskTop, Win 3.1 L1, MC Text, PC-852, Win 3.1 
L5, Win 3.1 L2, CWI Hung, PC-857 TK, ISO L2, ISO L5, PC-8 TK, 
Kamenicky, Hebrew NC, Hebrew OC, Plska Mazvia, ISO L6, Win 3.1 
Heb, Win 3.1 Cyr, PC-866, Win 3.1 Grk, PC-869, PC-855, 
Greek-437, Greek-437 Cy, Greek-737, Greek-928, Serbo Croat2, 
Ukrainian, Bulgarian, PC-1004, Win 3.1 Blt, PC-775, Serbo Croat1, 
PC-858, Roman-9, ISO L9

Letter O Style Enable
Disable

Sets the letter O style.

Zero Character Normal
Slashed

Sets the 0 style.

Line Pitch 6 LPI
8 LPI

Sets the line pitch.

White Page Skip On
Off

Sets whether a blank sheet is 
ejected.

CR Function CR
CR+LF

Sets the action when the CR 
code is received.

Line Length 80 column
136 column

Sets the number of characters 
per line.

Form Length 11 inch
11.7 inch
12 inch

Sets the paper length.

TOF Position 0.0 inch
0.1 ~ 1.0 inch

Sets the print position from the 
top edge of the paper.

Left Margin 0.0 inch
0.1 ~ 1.0 inch

Sets the print position from the 
left edge of the paper.

Fit to Letter Enable
Disable

Sets the print mode that fits 
print data equivalent to 11 inch 
(66 lines) into Letter size 
printable area.

Text Height Same
Diff

Sets character height.
Same: same height, regardless 
of CPI.
Diff: character heights vary 
according to CPI.

Continuous Paper 
Mode

On
Off

Sets the edit direction of paper 
supported by A3 printer to 
landscape.
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Color setup

Memory setup

Flash memory setup

ITEM VALUE DESCRIPTION

Ink Simulation OFF 
SWOP Euroscale 
Japan

Simulates a standard printing colour by the printer. 
The function is valid only for jobs using PS 
languages.

UCR Low 
Medium
High

Sets toner layer thickness. (Medium or Low may 
help reduce any paper curl that occurs.)

CMY 100% 
Density

Enable 
Disable

Enable/disable 100% output against CMY100% TRC 
compensation. Ordinarily, the TRC compensation 
function produces appropriate print density, so 
100% output is not always enabled.
Selecting ENABLE will enable 100% output in 
individual colour. The actual print, including the 
TRC compensation function is limited to an 
appropriate area. This function is for a special 
purpose such as specification in CMYK colour 
diminution of PS.

CMYK 
Conversion

On 
Off

Set to OFF to simplify the conversion process of 
CMYK data and reduce the processing time.
This setting is ignored when the Ink Simulation 
function is used.

ITEM VALUE DESCRIPTION

Receive Buffer Size Auto
0.5 megabyte 
1 megabyte 
2 megabyte 
4 megabyte 
8 megabyte 
16 megabyte 
32 megabyte

Sets the size of the receive buffer.

Resource Save Auto
OFF
0.5 megabyte 
1 megabyte 
2 megabyte 
4 megabyte 
8 megabyte 
16 megabyte 
32 megabyte

Sets the size of the resource saving area.

ITEM VALUE DESCRIPTION

Initialize Execute Initializes resident flash memory.

Resize PS Area nn% [n.n megabyte] Sets the size of the PS area in resident 
flash memory.
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HDD setup

System setup

Change password

Settings

ITEM SUBMENU 
ITEM

VALUE DESCRIPTION

Initialize Execute Initializes the HDD to the 
factory default state. 

Resize Partition PCL
Common
PS

nn%
mm%
ll%

Sets partition size. 

Format Partition PCL
Common
PS

Sets the format of a specified 
partition. 

ITEM VALUE DESCRIPTION

Near Life LED Enable
Disable

Enables the Attention LED to be turned on when a 
warning for NEAR LIFE of a toner, a drum, a fuser, 
or a belt occurs.

ITEM VALUE DESCRIPTION

New Password ****** Sets a new password to enter Admin Setup.

Verify Password ****** Lets a user verify the new password to be used to 
enter Admin Setup.

ITEM VALUE DESCRIPTION

Reset Settings Execute Resets EEPROM of the CU. Returns a user’s menu 
setup to the factory default state.

Save Settings Execute Saves the current menu settings.

Restore Settings Execute Changes the menu settings saved.
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CALIBRATION MENU

ITEM VALUE OR 
SUBMENU 
ENTRY

VALUE DESCRIPTION

Auto density mode ON
OFF

– Sets whether density adjustment 
and TRC compensation is 
automatically performed.
ON: density adjustment is 
automatically run under the printer 
specified conditions and reflected in 
TRC compensation.
OFF: the printer does not carry out 
density adjustment automatically.

Auto BG adjust 
mode

Off
-1
0
+1
+2

- Prevents dirty print backgrounds 
caused by unstable toner-charging 
conditions. The print density sensor 
detects the toner electric potentials 
and automatically adjusts supply 
voltage (SB) and charging voltage 
(CH). The menu does not appear 
when auto density mode is set to 
OFF.

Adjust density Execute – When Execute is selected, the 
printer carries out density 
compensation immediately and 
reflects it in TRC compensation. 
Density adjustment must be 
carried out when the printer is 
idling.

Adjust registration Execute – When Execute is selected, the 
printer carries out registration 
adjustment automatically. 
Registration adjustment must be 
carried out when the printer is 
idling.

Heavy media 
adjust

Off 
-5
-4
-3 
-2 
-1 
0
+1 
+2 
+3 
+4
+5

- Adjusts the fusing speeds for 
printing on heavy media.

A value other than OFF adjusts the 
speed based on the automatic-
adjustment value that has been 
set.

Print tuning 
pattern

Execute – Allows you to print a pattern to 
help you adjust TRC manually. 
(Normally, TRC is automatically 
adjusted to the recommended 
levels through density adjustment 
and TRC compensation.)
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Cyan Tuning

Magenta Tuning

Yellow Tuning

Black Tuning

Highlight 0 
+1 
+2 
+3 
-3 
-2 
-1 

Adjusts highlight (light area) of 
Cyan, Magenta, Yellow, or Black 
TRC.

Plus indicates adjustment towards 
darker and minus towards lighter.

Mid-Tone 0 
+1 
+2 
+3 
-3 
-2 
-1 

Adjusts mid tone of Cyan, Magenta, 
Yellow, or Black  TRC.

Plus indicates adjustment towards 
darker and minus towards lighter.

Dark 0 
+1 
+2 
+3 
-3 
-2 
-1 

Adjusts dark (dense area) of Cyan, 
Magenta, Yellow, or Black  TRC.

Plus indicates adjustment towards 
darker and minus towards lighter.

Cyan Darkness

Magenta Darkness

Yellow Darkness

Black Darkness

0 
+1 
+2 
+3 
-3 
-2 
-1 

- Adjusts the engine density.

The darkness settings are offset 
(additional) values on the results of 
the adjustments made with the 
Adjust Density or Tuning functions.

ITEM VALUE OR 
SUBMENU 
ENTRY

VALUE DESCRIPTION
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PRINT STATISTICS MENU 

PRINTER MENU: BOOT MENU

To access the Boot Menu:

1. Turn the printer off.

2. Press and hold the ENTER key while turning the printer back on.

ITEM VALUE DESCRIPTION

Password entry nnnn Enter password. The default password is 0000 
(four zeroes).
When there is no support for the print statistics 
function, Print Statistics is not displayed.

Statistics log Enable 
Disable

Enables/Disables the print statistics function.

Log size 1 ~ 30 ~ 
100

Sets the log size.

Conditions for display:
- HDD is installed.
- Enable is selected in Functions > Print 
Statistics > Statistics Log.

Reset counter Execute Clears the counter back to zero.

Conditions for display:
Enable is selected in Functions > Print 
Statistics > Statistics Log.

Change password - Changes a password.

Conditions for display:
Enable is selected in Functions > Print 
Statistics > Statistics Log.

New password nnnn Sets a new password to enter the Print Statistics 
menu.

Verify password nnnn Input the new password again to confirm.

NOTE
Keep pressing the Enter button until INITIALISING appears on the display.
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PARALLEL SETUP

USB SETUP

ITEM VALUE DESCRIPTION

Parallel Enable
Disable

Enables/Disables the Centronics 
interface.

Bi-Direction Enable
Disable

Enables/Disables the bi-directional 
Centronics interface.

ECP Enable
Disable

Enables/Disables the ECP mode.

Ack Width Narrow
Medium
Wide

Sets the ACK width for compatible 
reception. 
Narrow = 0.5µs 
Medium = 1.0µs 
Wide = 3.0µs

Ack/Busy Timing Ack in Busy 
Ack while Busy

Sets the order to output the BUSY signal 
and ACK signal for compatible reception.

I-Prime 3 microseconds
50 microseconds
Disable

Sets the time to enable/disable the 
I-PRIME signal.

Offline Receive Enable
Disable

Enables/disables a function that 
maintains the receive-possible state 
without changing an interface signal even 
though an alarm occurs. When this is set 
to Enable, the interface keeps the 
receive-possible state even when you 
press the Off-line operating panel switch. 
The interface sends the BUSY signal only 
when the reception buffer is full or a 
service call occurs. 
This menu is not displayed on a Non-PS 
machine.

ITEM VALUE DESCRIPTION

USB Enable
Disable

Enables/Disables the USB interface.

Speed 480Mbps
12Mbps

Sets the maximum USB interface transfer 
speed.

Soft Reset Enable
Disable

Enables/Disables the Soft Reset command.

Offline Receive Enable
Disable

Enables/disables a function that maintains 
the receive-possible state without changing 
an interface signal even though an alarm 
occurs. When this is set to Enable, the 
interface keeps the receive-possible state 
even when you press the Off-line operating 
panel switch. The interface sends the BUSY 
signal only when the reception buffer is full 
or a service call occurs. 
This menu is not displayed on a Non-PS 
machine.

Serial Number Enable
Disable 

Enables/Disables the USB serial number, 
used to identify a USB device to which a PC 
is connected. 
Appendix: the printer menu > 84



SECURITY SETUP

STORAGE SETUP

ITEM VALUE DESCRIPTION

Job Limitation Off
Encrypted Job

Controls the job limitation mode. If 
Encrypted Job is selected the printer will 
only allow this type of job to be printed 
and will discard all others.

Reset Cipher Key Execute Resets the cipher key used for the 
encrypted hard disk. The data on the drive 
before the operation performed with this 
menu cannot be restored after the 
operation. Execute displays the following 
confirmation message:

Are Your Sure?

- Yes

- No

By selecting No, the display returns to the 
previous, menu screen. Selecting Yes 
reboots the printer automatically, resetting 
the cipher key.

Display condition:

- An applicable HDD has been installed in 
the printer.

- The encrypted hard disk function is 
enabled.

ITEM VALUE DESCRIPTION

Check File 
System

Execute Resolves any mismatch between actual 
memory and displayed memory available 
in a file system and performs 
administration data (FAT information) 
recovery. Performs these by file system. 
This function takes several tens of seconds 
to complete.
HDD: Performs recovery only for an HDD.

Check All Sectors Execute Performs recovery of a defective HDD 
sector information and a file system 
mismatch as mentioned above.
It takes 30 to 40 minutes to complete this 
function for an HDD of 10GB.

Enable HDD No
Yes

Even if a machine is inoperable at 
installation because an HDD has been 
damaged, you can make the machine 
operable by setting to NO to signify that 
no HDD is attached, regardless of the 
existence of an HDD. While NO is set, 
access to an HDD results in FAIL because 
the HDD is regarded as not attached even 
if the HDD is operating normally.
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POWER SETUP

LANGUAGE SETUP

Erase HDD Execute Appears only when an HDD has been 
installed in the printer.

This function erases all data from the disk 
so that the data cannot be restored.

Exiting the menu after a setting is made 
restarts the printer, starting erasing the 
disk. The percent progress of the erasing 
is displayed on the operation panel.

Pressing Enter displays the following 
confirmation message:

Are You Sure?

- Yes

- No

Selecting No returns the display to the 
previous menu screen. By selecting Yes, 
the menu is immediately exited, the 
printer reboots, and the erasing operation 
starts. Pressing and holding the Cancel 
button during erasing displays the 
following confirmation message for 
cancellation of the erasing:

Do You Cancel?

- Yes

- No

Selecting No continues the erasing. 
Selecting Yes cancels the erasing, formats 
the disk and restarts the printer.

Enable 
Initialization

No
Yes

Prevents a setup change accompanying 
initialization of Block Device (HDD, 
FLASH).

ITEM VALUE DESCRIPTION

Peak Power 
Control

Normal
Low

The fuser of the printer has two lamps. 
When the lamps turn on, the printer’s 
power draw increases dramatically.

Normal:  Both lamps light at the same 
time. When this happens, the printer’s 
power draw increases dramatically.

Low: The lamps do NOT light at the same 
time. The printer’s electrical draw 
increases, but not as dramatically.

Power Save Enable
Disable

Enables/Disables the power save mode.

Moisture Control On
Off

Sets Off/On of Moisture Control mode. 
When On, the printer may take some time 
to complete printing the first-off sheet.

ITEM VALUE DESCRIPTION

Language 
Initialize

Execute

ITEM VALUE DESCRIPTION
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